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Student Style  Introduction 

Introduction 
You have probably been asked by a teacher somewhere down the line to adhere to 
certain standards in your work. This includes having your papers double-spaced with a 
hanging indention on your paragraphs, where your name, date and assignment title 
goes as well as conventions for citing sources. You’ve probably noticed that there are 
similarities from one class to another but more often than not, each teacher has his or 
her own criteria for your assignments. This criteria is called style and it affects the 
overall appearance and writing style of your writing. 

A style guide is a set of rules established by an organization which specifies the 
details of writing style. The style rules usually apply to the punctuation, capitalization, 
formatting, and construction of a document. Style guides are used to ensure 
consistency. Style guides are especially crucial to large companies that employ a large 
number of writers because it helps to ensure that the documents have a unified 
appearance and voice.  

Even in areas other than technical writing, such as creative writing, fiction, non-fiction 
and even some journalism, you may be required to adhere to a style guide. Publishing 
houses all have style guides as do most companies that produce documentation for 
products. When you work for a company writer, your work is often your company’s 
work and should reflect little of your individual personality; rather, your work 
represents the company’s individuality and personality. Most companies require that 
you follow their own standards of style and many have their own internal style guide. 
Larger companies like Sun Microsystems and Microsoft have publicly published their 
style guides. Smaller companies often have proprietary style guides that you shouldn’t 
share outside your company should you be working in this kind of environment. 

The technical and business writing classes provided by the TWRT Department at 
DeAnza tries to educate you in a manner that exposes you to real-world situations to 
better prepare you for your career. The classes are modeled to assist you in many 
different career paths, not just in technical writing, but in project management, 
engineering, desktop publishing, administration, and many others. Use this style 
Guide to help with all the assignments from TWRT 61 through TWRT 64. Sometimes 
there are other style guides that can provide further information that may assist you in 
your work. These other guides are listed in Appendix: References. You can find them 
at the DeAnza Library and often at the DeAnza bookstore. 

Some of the information here has been pulled together from the TWRT class readers. 
The information is meant to supplement your lectures and assist you in the writing 
process. Included in this guide are instructions on how to format your document and 
text as well as working with styles in Microsoft® Word. Student Style contains 
writing advice with software instructions and put them into one format for quick and 
easy reference. Whether you’re a novice Word user or an expert, you’ll find this guide 
to be a useful resource not only for your TWRT classes, but throughout your career.
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Getting Started in TWRT 
The courses are mainly referred to as Technical Writing (TWRT), but are also listed 
under English Writing (EWRT) and Business (BUS). You may be taking just one 
TWRT course or perhaps you’re taking the entire suite of TWRT courses. Whichever 
path you choose, each individual assignment is geared toward helping you in your 
career endeavors. Nearly every career requires a certain level of writing. Whether 
you’re a technical writer or Office Manager, or perhaps a general contractor to a 
restaurateur, you’ll need to know how to communicate your ideas clearly in writing. 
The program is especially helpful for technical writers, software engineers, project 
managers, desktop publishers and publications managers. 

You are encouraged to use your own judgment and creativity in all aspects of the 
coursework. Though you are bound to your employers’ requirements in your work, 
technical writing demands a great deal of creativity. The information in this book is 
intended as a guide, not as a rule book. Your teacher might emphasize specific criteria 
that you should follow from assignment to assignment. If your company has a style 
guide, you should use it as a rule book rather than a guide. Companies are strict with 
their style requirements. You need to find a balance between your own creativity and 
the confines enforced by the style guides you are expected to follow. 

Unlike other style guides, Student Style also provides you with advice on how to use 
the software involved in the writing process. The instructions provided are for 
Microsoft® Word since it is the most widely used among students, though in the 
corporate world, you may be asked to learn various applications in your writing 
process. 

If you’re unfamiliar with a word processing program such as Microsoft® Word, you 
should enroll in a course. DeAnza offers many courses in a distance learning 
environment that you can take along with your TWRT classes. If you are familiar with 
Word but aren’t a power user, that’s okay. You don’t need to be a software expert to 
complete your assignments. You’ll find much of the software guidance you need 
throughout the program to enhance your software skills. 

TWRT Certificate of Achievement 
DeAnza College offers this credential in Technical Writing, which is highly rated by 
employers in the area. Those that have earned this certificate have a leg up in getting 
any job that requires writing (which is nearly any job in the Bay Area). 

To obtain the certificate, you need to successfully complete the 16 units of Technical 
Writing classes offered throughout the school year (see TWRT Courses). Not all 
classes are offered every quarter so pay mind to which classes are offered when to 
ensure timely completion of the course. Work with your counselor for academic 
planning and to apply for the certificate. For more information on the Technical 
Writing classes and programs, see the DeAnza Catalog of Certificates and Degrees 
located at:  
http://www.deanza.edu/publications/catalog/2005-2006/CertsDegrees.pdf.
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TWRT Associate of Arts Degree 
The AA in Technical Writing gives you a greater advantage if you wish to pursue a 
career as a Technical Writer. The associate’s degree proves to employers that you 
know your material and have the skills they need. As with the certificate, the same 
four Technical Writing classes are essential to obtaining the degree. Plan your 
schedule wisely so that you are able to take the courses as they are offered. In addition 
to the TWRT classes, you’ll be required to fulfill all DeAnza general education 
requirements as well as 29 units of electives from the list located in the DeAnza 
Catalog of Certificates and Degrees located at 
http://www.deanza.edu/publications/catalog/2005-2006/CertsDegrees.pdf.  

TWRT Courses 
Each course in the Technical Writing program is designed to help you increase your 
skills in business writing and technical writing, as well as teach you how to get a job 
and keep that job. You’ll learn from highly experienced instructors who have worked 
as Technical Writers and Publications Managers. You’ll start with the basic 
techniques for getting your job and work your way up to producing a large manual 
through a collaborative effort, just as you might in the corporate environment. 

The TWRT classes are structured to model the corporate environment where your 
teacher is your supervisor or manager. While each class may consist of a combination 
of lecture and workshop, the assignments are to be delivered to your teacher as if you 
were meeting deliverables for your employer.  

The four core classes offered by the DeAnza Technical Writing Department are: 

Class Description Units 
TWRT 61 Introduction to Technical Writing 4 
TWRT 62 Survey of Technical Writing 4 
TWRT 63 Technical Publications 4 
TWRT 64 Technical Writing Seminar 4 

Overview of TWRT 61 
TWRT 61 (also listed as EWRT 61 and BUS 61) introduces both the methodology 
and career aspects of technical writing. The focus is on techniques of technical writing 
for industry including business communications, process writing, document format, 
vocabulary, and document editing. Class assignments include drafting memos, cover 
letters, resumes, functional descriptions, and instructions and involve multiple drafts 
with peer editing. The final project involves creating a personal portfolio containing 
refined versions of the above assignments that can be presented to a prospective 
employer. 

Students engage in the following activities: 

• Exploring the World Wide Web to discover technical writing resources  

• Marketing their strengths with a resume and cover letter  

• Identifying topics, audiences, and purposes for writing  
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• Outlining, designing, and writing short documents  

• Using Styles in MS Word to create documents and templates  

• Compiling a portfolio of professional quality writing samples suitable for 
presenting at job interviews 

Overview of TWRT 62 
TWRT 62 (also listed as EWRT 62 and BUS 62) focuses on many types of writing 
assignments in the technical and business world. Program planning and project 
management skills are emphasized as students work individually and in groups on a 
variety of increasingly complex assignments in short formats. Projects are drawn from 
case studies simulating real world assignments in a variety of industries. 

Students work on the following assignments: 

• Technical correspondence  

• Analytical reports  

• Proposals  

• Project plans and schedules  

• Progress reports  

• PowerPoint presentations  

• Empirical research reports 

Overview of TWRT 63 
TWRT 63 (also listed as EWRT 63 and BUS 63) focuses on building the writing and 
editing skills necessary to write a technical document. Individual and group 
assignments are utilized to develop organizational skills and document solutions. The 
final product is professional quality 30-35 page user's manual that provides concise, 
comprehensive descriptions and step-by-step instructions for making an item, 
operating a device, or carrying out a process. 

The assignments in TWRT 63 include: 

• Project proposal  

• Functional specification  

• Document blueprint  

• Review drafts  

• Final, camera-ready artwork and prototype 

Overview of TWRT 64 
TWRT 64 focuses on preparing a team-produced professional document. A project is 
assigned to a team for submitting to a predetermined client. Students are responsible 
for researching and planning their topic, meeting with the client(s), planning and 
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drafting their project, and submitting a final deliverable.  Class activities and 
assignments include an oral presentation of the team project and writing an individual 
article for publication. 

Students create the following: 

• Project Plan 

• Progress reports 

• Team produced manual 

• Article for publication 

TWRT Assignments 
As discussed in the last section, you create different types of documents during the 
TWRT program. Each course under the TWRT program is focused for different skills 
and work environments. While you develop many of the documents individually, 
some of these documents are generated as a group effort. 

Résumés 
A résumé tells about your skills and achievements to a prospective employer. Your 
résumé must tell everything about your education, experience, special achievements, 
interests, and any other detail about you that may be relevant to the job. 

There are different ways to design your résumé, you can group your achievements and 
experiences on jobs you have held or skills you have acquired. Place your contact 
information at the beginning of the résumé, also try to highlight this information using 
different fonts, graphic elements such as lines, shading.  

Try to keep your résumé to be under two pages long. Use 20-30 lbs paper for printing 
your résumé. Use of fonts is discussed in later chapters, but use san serif fonts for 
headings and serif for body text and bullets. 

Cover Letters 
The cover letter accompanies your résumé and job application. The cover letter 
explains how your qualifications and experience are suitable for the job listed. Cover 
letter is also a tool to highlight any specific aspect of the resume; for example, you 
may want to describe your 5 years experience as Health educator in details. In brief 
you can use the cover letter to explain and describe your achievements, and project 
yourself appropriate for the job.  

In the body of the letter, give the reasons why you are the right candidate for the job. 
Try to follow the requirements listed on the job description but don’t restate your 
résumé. Your cover letter is a chance to present new information. 

Try to keep the cover letter to a page length. Provide the correct address and other 
contact information. Make sure you spell all the proper nouns in the cover letter 
correctly.  
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Memorandums 
A memorandum or memo is written to communicate short ideas within an 
organization. A memo is generally used to communicate official and formal 
information. Apart from the content information a memo must have: 

• Name of the organization, when the memo is not printed on the company’s 
letterhead. 

• The word ‘Memo’ cantered or left justified, below the organization 
information.  

• Headings such as: To, From, Subject and Date. These headings should be left 
justified. 

• Add the job titles after the name and the department name after the title if you 
work for a large organization. 

The body text in a memo is always left-justified. The paragraphs are not indented. 
Adjust the spacing between the paragraphs to provide readability. 

Functional Descriptions 
A Functional Description describes the overall function and appearance of a 
mechanism or product. A functional Description must describe each part of the 
mechanism or the product.  This document explains how the product operates or is 
used, and how each part contributes to the functioning of the entire mechanism.  

When writing the description, be as accurate as you can be about the measurements 
such as weight, size, volume etc. Use correct words to identify the various parts. 
Explain any technical terms before using them. 

Procedures 
Many documents require you to write procedures, basically instructions in a logical 
format. These instructions can be for building a product, performing some activity, 
installing or using some product.  

When writing instructions use the active voice and tell the users the necessary actions 
they need to perform. Use simple language to explain the steps. 

Analytical Reports 
Analytical Reports analyze data and recommend action to be taken based on the 
conclusions reached in the report. When the report makes a recommendation, it is 
called a recommendation report. And when the report examines the possibility of a 
plan and its feasibility, it is known as the feasibility report. 

The analytical report may contain the following parts: 

• Title page 

• Table of Contents 
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• Summary 

• Introduction 

• Discussion 

• Conclusion 

• Recommendations 

Project Proposals 
Proposals are a method of offering services for price. A proposal should indicate how 
you are capable of providing the services needed and should also state the fees for the 
services quoted.  

Proposals may be short or long. Small proposals can be written as letter of 
correspondence; where as the longer proposal could be written as reports.  

Proposals written in the report format may contain the following parts: 

• Project Summary 

• Description 

• Introduction 

• Plan  

• Personnel  

• Budget 

Progress Reports 
A progress report states the current work status in a project. A progress report may be 
required at fixed intervals in the lifetime of a project to indicate the status of work.  

The progress report can be written in from of a letter when the report is small, but 
when the report is lengthy the format is usually same as other longer reports.  

A typical progress report may contain the following parts: 

• Introduction 

• Project Description 

• Work Completed 

• Work planned 

• Appraisal of Progress 
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Empirical Research Reports 
This report may be developed in class as a group project. The empirical report is a 
scientific research report, formatted to show the stages of the scientific methods used 
in a study. 

This report may include the following: 

• Abstract 

• Introduction 

• Literature Review 

• Materials and Methods 

• Results 

• Discussion 

• Conclusions 

Blueprints 
A blueprint is the outline for a project. Blueprints basically give the client and writers 
an idea how the final product looks. The blueprint states the complete description of 
the project, such as the team members, responsibilities, and timelines. 

Presentations 
You may, in any of the classes, be required to create a presentation using PowerPoint. 
The assignment may be a group or individual project. When working as a group, try to 
divide the work in a method that utilizes each team member’s strengths while giving 
everyone an opportunity to be included in the presentation. Presentations are required 
often in the workplace so this is an excellent opportunity to hone your skills and 
reduce stage fright. 

User’s Guides and Manuals 
In TWRT 63, you’ll be writing a manual of approximately 30 pages. In TWRT 64, 
you’ll be required to collaborate with a team on a project for a real client. The project 
includes a manual of about 75 to 100 pages. While this may sound intimidating in the 
beginning, you’ll receive the training and support you need to get the project 
completed on time. For more information on publishing your own manual, see 
Supplement: Publishing Your Manual, included at the end of this document. 
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Writing Style 
Your writing style is unique to you. In the corporate environment you should try to 
modify the style the best that you can so that you match the corporate image in all of 
your company’s documentation. Most manuals are a collaborative effort of work, 
written by many writers, sometimes working in different departments and sometimes, 
different countries. Writing style includes the way you use grammar, punctuation, 
abbreviations, verbiage, and term usage. Word choice is important to give your 
collaborative work a unified voice. Though the following information is intended to 
guide you with writing style and word choice, you should find your own voice and 
style in your individual assignments. 

Choosing Your Words 
Your writing style must be tailored to your target audience. Choose the appropriate 
words to explain exactly what you want your audience to understand. Select words 
that most accurately and effectively convey your meaning.  Your audience could be 
easily misled or your meaning misunderstood if you use the wrong word or one with 
ambiguous meaning. Make sure that you know the correct definition of the word used. 
When in doubt, consult a dictionary. 

Word choice advice for the new TWRT student: 

• Use vocabulary that is specific and concrete. Avoid abstractions. For example, 
use Kodak DX6340, as opposed to the general term camera. 

• Avoid words that are gender specific. For example, when describing 
occupations, do not use titles that suggest whether a person is male or female. 
Use mail carrier instead of mailman, flight attendant instead of stewardess. 

• Avoid industry jargon or words that are not commonly used outside of certain 
groups. If you must use jargon, make sure that it is appropriate for the reader 
and define it. Don't use BDU unless you are certain your audience knows this 
means military uniform (Battle Dress Uniform).  

• Avoid using clichés and slang such as, each and every, needless to say, and 
he's not with it. Clichés don’t translate well across cultures and can be 
disastrous especially when your work is translated into other languages. 

• Use simple words instead of complex ones. For instance, use instead of 
utilize. 

• Use numbers and their word equivalents in a consistent fashion. For numbers 
ten and under, write out the numbers by word (one thru ten), and for numbers 
above ten, write out the numbers in numeric form (11, 12, 13...). If expressing 
a range of numbers, follow either form as long as it is consistent, as in two 
thru eighteen, or 2-18.Use present tense as a standard. For instance, write the 
dialog box appears as opposed to the dialog box will appear. 

• Use the proper case of pronouns. For instance, Blake and I stayed home, as 
opposed to Me and Blake stayed home. In this instance, the wrong case of the 
pronoun is used. Make sure pronouns agree with their noun antecedents. For 
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example The student left their book behind should be written, The student left 
his or her book behind. The student is singular, while their is plural. 

Common Verbiage Mistakes 
Many words sound the same and have similar meanings but mistaking them in your 
documentation can prove to be very embarrassing and can also give your readers the 
wrong impression. Be careful with commonly confused words and know the 
difference between words that sound the same. 

Learn the differences of these commonly misused words: 

To / Too: To is a preposition indicating towards, as in She walked to the store. Too 
means also, as in Her boyfriend went, too. 

There / Their: There indicates place, as in The school is closed, so he can't go there. 
Their is a possessive pronoun that indicates belonging, as in Their school is closed 
(the school that they go to is closed). 

Effect / Affect: Effect is a noun indicating result or consequence, as in His protest had 
no effect. Affect is a verb which has several meanings—to produce an effect or 
change, as in Cold weather affected the crops. or to give the appearance of or to 
pretend, as in To affect a southern accent. Thirdly, as a scientific term, affect means to 
tend towards habitually or naturally, as in a substance that affects colloidal form. 

Compliment / Complement: Compliment is a pleasantry, as in You look great. 
Complement indicates completing or making perfect, as in The scarf complements the 
suit. 

Then / Than: Then indicates time, as in Prices were lower then. Than is used after 
comparative adjectives and adverbs, as in She is taller than I am. 

Its / It’s: Its expresses ownership, as in The dog bit its tail. It's is a contraction of the 
two words, it and is--when a letter is removed, it is replaced by an apostrophe, as in 
It's raining, again. 

Principal / Principle: Principal express first or highest in rank or value, as in The 
Principal of the school. Principle is a rule of action or conduct, as in He refused, on 
principle, to accept a bribe. 

Being Concise 
To write concisely, you write direct, to the point, and express a great deal in just a few 
words. In concise writing, you cut down on confusing bulk by explaining briefly, 
clearly, and simply while still getting your point across. You eliminate unnecessary 
detail and verbiage from a more wordy statement. A concise work helps your readers 
to comprehend the point quickly and accurately. 

• Avoid metadiscourse that attempts to impress or stretch an idea through 
unnecessary extra words and phrases.  For example, It can be said, for all 
intensive purposes, that across the great span of time, nowhere was there a 
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more ferocious beast than the T-Rex is an attempt to make a simple thought 
sound very intelligent. A concise way to write the same thought would be, 
Some suggest that the T-Rex was the most ferocious beast of all time. 

• Avoid bureaucratese and wordiness that buries significant ideas and 
information. Nobody wants to read something like, Over the most recent 
monthly period, there has been a large increase in the number of complaints 
that customers have made about service that has been slow. When it can be 
expressed as, Last month, a lot more customers complained about slow 
service. 

• Omit unnecessary words. Find where you can substitute one word for many. 
For example, The physical size of the workroom is too small to accommodate 
the equipment could be expressed, The workroom is too small  

Writing Paragraphs 
Paragraphs are made up of a series of sentences that convey a single idea. Paragraphs 
are constructed from a series of sentences to explain the complexities of a concept or 
idea.  

• Avoid a succession of loose sentences. Smooth the flow from sentence to 
sentence. Form logical paragraphs with good paragraph structure. A well-
written paragraph introduces your readers to the idea first and leads them 
through the details.  

• Begin each paragraph with a topic sentence. Keep the same general topic in 
each sentence of the paragraph.  Ensure sentences move from old to new 
information. In any paragraph, the first sentence should state the topic and 
subsequent sentences expand on it.  For example, To tighten screw, use a #4 
hex wrench.  The #4 hex wrench… 

Frequently, the end of the paragraph has a transition containing a new idea that acts as 
lead-in for the next paragraph. 

Styles and formatting recommendations for paragraphs: 

• Avoid monotony—vary your sentence length and structure. 

• Use simple language and analogies to help readers visualize the content. For 
example, The crank assembly operates much like the pedals on a bicycle. 

• Provide your readers with context. Never give them steps with no explanation 
as to when and why they complete those steps. 

Constructing Sentences 
The way you construct your sentences and use grammar is also known as syntax. 
Make sure your sentence construction efficiently reflects what you mean to say. You 
probably learned the fundamentals of sentence construction in grammar school. Each 
sentence must contain a subject and a verb. Make sure that the subject agrees with the 
verb. 
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Make sure that when you construct a sentence that it conveys the meaning you intend. 
Take, for example, The woman in the seat hit the man, or The woman hit the man in 
the seat. In the first sentence, the phrase in the seat describes the woman. In the 
second sentence, the phrase in the seat describes the man.  

Problems arise when a phrase is incorrectly placed in a sentence. Avoid separating 
phrases from the words they describe. For example, Running at top speed, his wig flew 
off suggests the wig is running at top speed. The subject that running at top speed 
modifies does not appear in the sentence. Here are some correct examples using he as 
the subject: 

• He was running at top speed when his wig flew off. 

• As he was running at top speed, his wig flew off. 

• Running at top speed, he felt his wig fly off. 
More advice for writing sentences: 

• Do not use unclear demonstratives like this, that, these, or those without a 
qualifying noun following. For example, This step is repeated, not This is 
repeated. 

• Arrange sentences to put the most important information at the end. An 
example of this is, Because of its hardness, this steel is used principally for 
making razors, not This steel is principally used for making razors, because of 
its hardness. Your readers will remember the beginning and end of a long 
sentence more easily than the middle, and will remember the end most clearly 
because it is the last thing they read. 

• Place the emphatic words of a sentence at the end. Emphasize by position, He 
topped his sales quota even though he was sick for an entire week. 

• Place key information in the main clause. The main clause is the independent 
clause, which means that it can stand alone as a sentence. A dependent clause 
is introduced by a relative pronoun or linking conjunction such as, that, 
which, because, or although. An example is, Although our profits were up, 
our productivity was down. The important point is that productivity is down. 
Another example is, The lamp, which was a priceless heirloom, lay smashed 
on the floor. The main point is that the lamp is broken. 

• Put statements in positive form. Identify negatives and change to affirmatives 
where possible. He usually came late instead of He was often not on time. 

• Identify nominalizations and change them to their verb forms as much as 
possible. Nominalizations are the noun versions of a verb, and often end in -
ion, bulking the sentence out and requiring extra words to say the same thing. 
For example, in This procedure protects against reinfection, protects is 
nominalized by writing This procedure is a protection against reinfection, . 

Using Appropriate Punctuation 
Punctuation is the method used to indicate the way a sentence is supposed to be read. 
Punctuation marks are used to show pauses, changes in inflection or tone, and to 
emphasize or clarify meaning. Punctuation makes the act of reading sentences easier 
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and to make the movement of the eye across the page smooth. Punctuation helps your 
audience understand the relationship of ideas. One of the older style guides published, 
Strunk & White’s The Elements of Style gives the rules of punctuation in an easy to 
read format and is recommended as a quick reference guide for punctuation and 
grammar. 

Some advice according to Strunk & White's “The Elements of Style”*: 

• Form the possessive singular of nouns by adding 's. Charles's friend, Burns's 
poems, or the witch's malice. 

• Enclose parenthetic expressions between commas. The best way to see a 
country, unless you are pressed for time, is to travel on foot. 

• Place a comma before a conjunction introducing an independent clause. The 
early records of the city have disappeared, and the story of its first years can 
no longer be reconstructed.  

• Do not join independent clauses with a comma. It is nearly half past five; we 
cannot reach town before dark. 

• Do not break sentences in two. I met them on a bus many years ago, coming 
home from Phoenix to Sedona as opposed to I met them on a bus many years 
ago. Coming home from Phoenix to Sedona. 

• Use a colon when making a list. The complete assembly requires three parts: 
the tail fin, the body, and the nose-cone as opposed to The complete assembly 
requires: the tail fin, the body, and the nose-cone. 

• Use a dash to set off an abrupt break or interruption and to announce a long 
appositive or summary. The first step in assembling your organizer—
assuming you prefer the vertical orientation—is to remove the lower retaining 
clips. 

• Avoid using words in all capital letters. Capitalize all significant nouns in 
headings, such as Training Manual, Exercises, and Procedures. Also, 
capitalize acronyms. 

*Adopted from “The Elements of Style” by Strunk Jr. and E.B. White, 3rd Edition 

Writing Style Conventions 
In technical writing, you document processes and instruct, or describe the topic. You 
write and design not from the point of view of what you know, but from the point of 
view of what inexperienced or beginning users need to know. You create 
communications to meet an audience's needs and interests. The main subject or topic 
of communication determines the kind of information you write and the form it takes. 

You communicate directly and concisely so that your audience can easily and safely 
make use of your information. You use terminology, language, and organization that 
your readers can understand and readily identify with. You communicate directly, 
personally, and in a complete, but no-nonsense manner.*

• Do not use the first person. Delete any occurrences of “I”.  

• Use active voice instead of passive:  
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Active: The consultant recommended these changes.  
Passive: The changes were recommended by the consultant. 

• Be sure tenses are accurate and consistent. For example, “You will have 
removed the shaft after you will be loosening the retaining nut” mixes tenses. 

• Use present tense as a standard. For instance, write the dialog box appears, as 
opposed to, the dialog box will appear, or the dialog box should have 
appeared. Be sure tenses are accurate and consistent. For example, You will 
have removed the shaft after you will be loosening the retaining nut, mixes 
tenses. 

• Do not talk about this document, this manual or these instructions. Instead 
talk directly to the reader about the process, you and changing your car's oil. 

• Do not use terms like the user or the reader when writing user documentation. 
Instead, use You. 

*From Technical Communications 95 
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Starting Your Document 
Customizing your software and setting up your page layout are the first steps to 
writing any of your assignments. Some simple ways of setting up the way you view 
your document and work saves you time and trouble later. 

Understanding Your Software 
Most students use Microsoft® Word, though you may use any software application 
that suits you best. The instructions given here are for Microsoft® Word users and are 
here to help save you time as you get working on your writing projects. There are 
many ways you can set up your software so that you can easily see and understand 
your formatting and quickly make any necessary adjustments. 

Viewing Hidden Text 
Hidden text includes tools for spacing like hard returns, soft returns, tabs, spaces, and 
the end of table cells. Hard returns are used to create new paragraphs. A soft return 
provides a line break within your paragraph and maintains paragraph formatting. You 
should set up your software to view hidden text before you begin working on your 
document. To view hidden text, simply toggle the Show/Hide Text icon:  

Symbols you’ll see when viewing hidden text: 

• Hard return:  

• Soft Return:  

• Space:  

• Tab:  

• Table cell end:  

Viewing Field Codes 
In Microsoft® Word and many other word processors, fields are used as placeholders 
for data that might change in a document. They are also used for mail merge 
functions. Word inserts fields when you use certain features, such as cross-references. 
You are really creating fields when you create a table of contents or an index.  

Fields appear in your document highlighted in gray and are deleted by a single press 
of the delete key, as opposed to deleting each character separately. Some field codes 
are surrounded by the { and } characters. Field codes remain hidden or reveal the 
content they represent, such as a date, unless you choose to show the codes. To show 

field codes, click the View Field Codes icon:  
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Examples of field codes: 

• Table of contents field: { TOC \h \z \t "Heading 1,2,Heading 
2,3,TitlesChapter,1" } 

• Index entry field: { XE "Software:Understanding" } 

• Linked picture: { INCLUDEPICTURE "MyWork/FCicon.gif" \* 
MERGEFORMAT } 

NOTE! 

NOTE! 
Hidden text is your friend. Don’t be intimidated by the marks that reveal 
formatting and fields. You’ll soon become familiar with them and wonder 
how you ever worked without them. 

 

Showing Your Rulers 
Rulers show your document measurements in inches on the top and left of your 
screen. Showing your rulers can help you to set up your page layout and format your 
paragraphs and tabs as you work. To show your rulers, simply click View → Ruler.  

 
Showing rulers helps you with page formatting. 

 
The gray areas on a ruler indicate your margins. The triangles show your 
paragraph indentations. 

Setting up Page Layout 
The appearance of your page is the key to communicating to your reader.  Margins, 
spacing between words, and the hierarchy of your headings and body text all 
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determine whether your reader would want to keep reading your content.  Proper page 
layout allows the beginning user to recognize your organization quickly and to 
assimilate the ideas quickly.  If formatted well, the same page layout allows the 
returning, or “power” user to access and reference main points without stumbling 
through endless blocks of body text. 

You should set up your page layout before you begin writing. This includes setting 
margins and determining where your text goes. The previous section discussed 
showing rulers. Rulers help you set your margins, tabs, and indentations. To access 
the page setup dialog box, simply double-click in the gray area in your ruler, or click 
File → Page Setup. The sections that follow are intended to help you to set up your 
page layout for most documents but remember that all documents are different and 
may require different settings. 

White Space & Readability 
White space is the area on a page that is not used by text or images. Essentially, if you 
print your document on a white sheet of paper, the white space is literally the white 
space. This includes the blank space created by your margins, how you indent your 
headings and body text, and images. Effective white space contrasts the text, creating 
balance on each page of your document. This balance makes the page more readable 
since the reader clearly sees the organization of information and visually rests 
between sections of information. 

Never use a hard return to create vertical space. Instead, set space before and space 
after in the paragraph format (see Formatting Paragraphs). Always work with your 
hidden text (also called text markings) showing on the screen.  Simply select the 
Show/Hide Text icon:  

Page formatting recommendations for creating white space in large documents: 

• Create one-inch margins all around your document, and then make 
adjustments as needed. Don’t use the Word default margins.  

• Organize your headings and body text so that you’ll have about a two-inch 
wide column of white space on the left side in which only H1s and probably 
H2s appear, (see Section Headings). 

• Begin all of your body text at the same indent level. Your body text doesn’t 
have to be parallel with your headings.  

• Visibly group information in the same section together by using proportionate 
spacing, (see Formatting Paragraphs). When creating space before and after 
headings, make the space above greater than the space below (except, 
perhaps, for your Heading 1). 

• Use left justify  for your body text. Left justify aligns the text to the left 
leaving a ragged right edge.  
This text is an example of text that is left justified. Notice how the lines of text 
always begin at the same left edge, but that the right edge, where the text 
wraps, is jagged, meaning some lines end beyond others. However, the 
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spacing between the words is consistent, making this paragraph of text easy to 
read. 

• Don’t use full justify,  which creates larger spaces between the words to 
make the left and right edges of your paragraph even.  
This is an example of text that is full justified. Notice how the lines of text 
always begin at the same left edge like left justified text does, but that the 
right edge, where the text wraps, is also aligned. In order to create these 
justified lines of text, spacing was automatically added between words. This 
spacing creates an inconsistent flow of text; therefore, making this paragraph 
more difficult to read. 

 
The above is an example of how to format your document to have a good balance 
of white space. Have a good balance of white space and text. Heading levels one 
and two appear in the white space on the left. Body text is aligned with heading 
three. 

Setting Margins 
Margins are bands of blank area along the top, bottom, and sides of your document 
that center and space your content from the edges of the paper.  Most printers cannot 
print to the very edge of the paper, and establishing margins organizes the text and 
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graphics visually.  You must provide horizontal paper space at the top and bottom of 
your page and vertical paper space at the sides. Avoid creating a very narrow column 
of body text. Keep your margins in perspective. Draw a quick diagram of your text 
layout, to understand the implications of the various margins, gutters, etc.  

Creating a 1" margin for 8.5" x 11" page: 

1. Click on the File menu and choose Page Setup. The Page Setup dialog box 
appears. Notice the tabs for Margins, Paper Size, Paper Source, and Layout. 

2. Click on the Margin tab.  The following task pane appears: 

  
3. Set the Top and Bottom margins for 1".  

4. Set the Left and Right margins for 1".  

5. Click OK when finished. 

For formatting suggestions for a 7”x9” manual, see Supplement: Publishing a Manual. 
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Using Templates 
Every Microsoft® Word document is based on a template. A template determines the 
basic structure for a document and the styles used for formatting your text. Document 
settings such as style, AutoText, and macros are attached to templates. The “.dot” 
extension is reserved for Microsoft Word document templates. Any template you 
create may use the .dot or the standard .doc extension. You should use the .doc 
extension if you’re unfamiliar with templates. For power user instructions on 
templates, see Supplement: Becoming a Template Expert. 

The default template in Word is Normal.dot. When you open a new document in 
Word, you are using the Normal.dot template. You don’t want to make any changes to 
the normal.dot template. Instead, you want to make your own templates to use in your 
TWRT documentation. 

 

Using a “.doc” Template 
You may create styles and attach them to a .doc file that you can use as a template for 
future documents. Doing it this way ensures that you won’t be overwriting any 
existing templates, mainly your Normal.dot template. Essentially, you’re creating a 
regular file that contains the styles you want to use in your documents. You may 
create a different .doc template for each type of document you produce in the TWRT 
classes. Many of them are used several times throughout the TWRT program, such as 
memos and progress reports. 

Creating a .doc template: 

1. Click the New Blank Document icon: . A fresh new document is created 
for you. 

2. Save your document File → Save As… and give it a unique name and ensure 
that it says Save as Type: Word Document (*.doc). 

 
3. Begin creating styles. 

Understanding Styles 
Styles affect the formatting of your text, images, figures, tables, and essentially most 
aspects of your document. Using styles is the best way to format your document. 
Don’t use hard returns, tabs, or spaces to format your text or you may find yourself 

Overwriting styl our 
documents. Only
then, use caution. 

es on the Normal.dot template affects nearly all of y
 use .dot templates if you are a template expert, and even 

NOTE! 

NOTE! 
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with trouble down the road. Using unconventional methods such as these are 
inconsistent and often don’t print as you intend. When you add text to a document, 
manual formatting has to be checked and reapplied. If you use styles to format your 
text, you have a better chance of your document looking the right way and it saves 
you time and effort throughout the whole writing process. 

Creating New Styles 
Styles control the way your text and figures appear in your document. In Microsoft® 
Word, styles are attached to templates, the underlying format for your documents. 
Styles can also be attached to documents without affecting the template. For this 
reason, you created your .doc template. You should have your new template file open. 
If not, open it to continue building your template. 

It’s best to have your Styles and Formatting Task Pane open when working with 
styles. The Styles and Formatting Task Pane gives you easy access to all of the styles 
and formatting available in your document and gives you the tools you need for 
making new styles or modifying existing ones. Access the Styles and formatting task 
pane by clicking the Styles and Formatting icon or through the menu Format → 
Styles and Formatting. You may also access the task pane by clicking the Styles and 
Formatting icon:  

You might want to use your initials before each style name, for instance, 
EHbold would be your own style for applying bold to a text. Naming 
conventions such as this allow you to not only identify your personal styles 
but to keep them in the same alphabetical order on your Styles and 
Formatting task pane. 

NOTE! 

NOTE! 

 
Working in the Styles and Formatting Task Pane to Create and Modify Styles: 

1. Click on the arrow to the far right of Show:, located at the bottom of the 
Styles and Formatting task pane, and select Formatting in Use to display a 
clean view of the styles used in your style sheet. 

 
2. Click the New Style button:  at the top of the task pane. The New 

Style dialog box appears. 
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3. Give your style a name and type it in the Name: field. Use a convention so 

that you may recognize each style you create.  

4. Choose the Style type from your choices of paragraph, character, table or list. 
Paragraph is the appropriate choice for most purposes. Character applies the 
style to just the characters (each individual letter or number), table applies the 
style to tables and list applies to numbered or bulleted lists. 

5. Select an existing style for Style based on, which means that your new style 
begins with the attributes of the style you choose. Choose a style on which 
you want to base your new style. If you’re unfamiliar with styles, you should 
base your new style on Normal. 

6. Enter the name of your new style in Style for Next Paragraph if your style 
will be continued in subsequent paragraphs, such as body text or lists. Most 
other styles, such as headings, should be followed by your basic body text 
style. 

7. Click the Format button on the bottom left of the New Style panel. 

8. Customize your new style by choosing the attributes through the Format 
menu. Most of the time, you should only be modifying the Font and 
Paragraph attributes. 

Format Choice Attributes 
Font Customizes Font, Font Size, Font Color, Underline Style 

and Font Effects. 
Paragraph Customizes paragraph styles attributes such as 

Alignment, Outline Level, Indentation, Spacing and 
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Format Choice Attributes 
Pagination. 

Tabs Places customized tab stops that are applied to 
paragraphs using your new style. 

Border Applies Borders and Shading attributes to your new 
style. 

Language Selects a language for your document other than English 
(the default). This should only be used if you are writing 
your document in an alternate language and have the 
corresponding dictionaries installed. 

Frame Applies frame attributes to your text. This treats 
whichever is in your new style as a graphic or object. 
You are unlikely to ever need to apply this attribute to 
your new style. 

Numbering Applies attributes to Bulleted and Numbered Lists. If 
you need to apply special attributes to Bulleted and 
Numbered Lists, you should rather apply the attributes 
through the Format menu. See Modifying Bulleted and 
Numbered Lists. 

Shortcut Key Assigns a special shortcut for applying your style. You 
should only do this if you are an advanced user as you 
should not overwrite an existing shortcut. 

9. Click OK to commit your changes. 

Do not check the Add to Template box. This adds your new styles to 
whichever .dot template you are using (most likely Normal.dot). You don’t 
want to overwrite your defaults. 

 

Modifying a Style 
You may choose to modify an existing style rather than create new ones. Be careful 
when modifying default styles, or the styles that are automatically in your Styles and 
Formatting task pane. You may want to modify your own styles after you’ve created 
them. Modifying an existing style is easier than creating a new style. 

Making changes to your existing styles: 

1. Open the Styles and Formatting task pane. 
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2. Scrub your mouse pointer over the style you wish to modify on the Styles and 
Formatting task pane, click on the arrow to the right of the style name: 

 
3. Choose Modify… - the following task pane appears: 

 
Some minor font and paragraph attributes can be made directly on this 
task pane.  

4. Choose the Format button and the appropriate selection; see Adding a New 
Style for more information.  

5. Make your modifications 

6. Click OK to commit your changes.
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Formatting Your Documents 
Guides and manuals have various elements such as headings, body text, bulleted lists, 
etc. You create distinct styles for each element of your document. Keep the style for 
your elements consistent throughout your document. This enables your reader to 
understand your writing better. The different elements of your document require 
different protocols of styles and formatting. Styles used in one document won’t 
necessarily apply to another. Many of the elements discussed in this chapter may 
apply to only one type of document, a few, such as body text (paragraph style) is 
likely to be applied to all of your documents. 

This chapter covers the following elements: 

• Front Matter for Manuals 

• Document Content 

• Back Matter for Manuals 
Styles and Formatting Quick Reference: 

Style Type Document Types Formatting suggestion 
Body Text All types • Serif 

• font size 10 to 12 
• Spacing after 
• Indented about 1” 

Bold All types • Titles 
• Headings 
• List intros 
• Commands 

Chapter Titles Guides and Manuals • Sans serif 
• Large font 
• Bold 
• Paragraph underline 
• Spacing below 
• Page break before 

Document Titles Guides and Manuals • Sans serif 
• Large font 
• Bold 

Heading 1 Guides and Manuals, 
Project Proposals, 
Analytical Reports, 
Empirical Research 
Reports 

• Sans Serif  
• Font smaller than Chapter 
• Flush with margin 

Heading 2 Guides and Manuals, 
Project Proposals, 
Analytical Reports, 
Empirical Research 
Reports 

• Sans serif 
• Font smaller than H1 
• Slight indent 

Italics All types • Use minimally 
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Style Type Document Types Formatting suggestion 
• Examples 

List Intros Any document that 
uses a bulleted or 
numbered list, with the 
exception of a résumé 

• Same as body text 
• Bold 
• End with colon 
• Spacing after 

Subheadings Guides and Manuals • Sans serif 
• Font smaller than H2 
• Flush with body text 

Tables All types • Header row bold 
• Minimal gridlines 

Underlining All types  • Use minimally 

Front Matter for Manuals 
Front matter is only applicable to your guides, manuals and larger documents. The 
front matter of a document includes all aspects that introduce your reader to your 
subject. Front matter can set the mood of the documentation by presenting images and 
creates the initial look and feel. Consider this to be your store front of your document. 
Try to make it as interesting and appealing in an effort to draw your reader further into 
your work. As with everything, however, keep it simple.  

Front matter consists of the following: 

• Title Page. 

• Copyright notice. 

• Table of contents (TOC). 

Title Pages 
With most documents created in TWRT, you won’t need a title page. A title page is 
only used for manuals and guides and then, only when your teacher requests one. 
When you do make a title page, you want to make it look good. Your title page should 
suit the nature of your document. In technical documentation, be clear and concise. 
Images are useful for enhancing the appearance of your document. Use simple images 
that won’t detract from the title of your document. 

Your title page should contain: 

• Title. 

• Subtitle (optional). 

• The author’s name (or company name). 

• Other information as requested by your instructor. 
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Titles 
Your Document Title must indicate the purpose and contents of the document. The 
Document Title names the information and helps your reader understand the purpose 
of the document. 

Title Style and Formatting suggestions: 

• Large font size of over 32. 

• Bolded. 

• May be in bold colors. 

• May be left, right or center aligned. 

Subtitles 
Subtitles are not necessary but can help to specify your document’s aim or purpose. 
Use of a subtitle may be necessary when your title refers to the general area of your 
document; the subtitle refers to the specific nature of the document. 

Subtitle Style consists of the following: 

• If the subtitle is standing independently, large font size just smaller than the 
title (must be distinguishable as a subtitle and not confused with the title). If 
the subtitle is preceded by a colon following the title, use the same style as the 
title. 

• Bolded. 

• May be in bold colors. 

• Align with the title or make the location complement the title. 

Table of Contents 
A table of contents (TOC) serves as your readers guide throughout your document. In 
technical manuals and large documents, readers want to quickly find the information 
they seek. A manual with well-formed table of contents makes the difference between 
your reader being satisfied or frustrated your work. The table of contents is formed by 
consolidating the chapter titles and headers of your document. 

The TOC is a field. This means that it is dynamic text that changes as you make your 
changes in the document. You need to manually update your TOC for the changes to 
show. For more information, see Updating a TOC. 

Creating a TOC 
Inserting a table of contents in Microsoft® Word is easy. Don’t forget to check it and 
make your customization before you click the final okay to have your TOC inserted. 
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Make sure you manually customize your TOC each time you insert it. 
The levels and some styles revert to the default values each time, so you 
need to check everything before finalizing the insertion of your TOC. 

 
To generate a TOC: 

1. Navigate to the page that you wish to contain your TOC (recommended after 
the Title and Copyright pages, but before the first chapter title). 

2. Label your Table of Contents at the top of the page, but use a style that is not 
a Heading or Chapter Title, otherwise the words Table of Contents will also 
appear within your Table of Contents field. 

3. Choose Insert → Reference → Index and Tables from the menu. The Index 
and Tables dialog box appears. 

 
Use the menu to insert a Table of Contents. 

 
The Index and Tables dialog box allows you to customize how your TOC 
appears. 

4. Choose the Table of Contents panel. 

5. Choose Options… to customize the order for your Table of Contents. 

28 



Student Style  Formatting Your Documents 

 
The Table of Contents Options pane enables you to customize the 
appearance of your TOC. 

6. Ensure that Styles is checked for building the table of contents from your set 
of styles (mainly chapter titles and headings). 

7. Navigate down the list, entering numbers in the TOC level boxes to indicate 
the order in which the headings appear in your TOC. You should only use the 
chapter titles and top 3 level headings for your TOC. 

8. Choose OK once you are satisfied with the TOC level order. 

9. Choose OK again to insert the TOC. 

You may get the message, “Do you want to replace the selected table of 
contents?” – in this case, choose ok. This will simply reinsert an updated 
table of contents in the same place as the first. 

NOTE! 

NOTE! 

 

Updating a TOC 
Updating your TOC is important, not only throughout the writing process but crucial 
to remember at the very end when you generate your final document. Fortunately, this 
is extremely quick and easy to accomplish.  

Updating your TOC: 

1. Navigate to your TOC. 

2. Select your TOC by clicking anywhere on the field. 

3. Hit the F9 key to bring up the Update Table of Contents dialog box. 
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4. Choose either to Update page numbers only (if you’ve made no heading 
changes) or to Update entire table (if you’ve made significant changes – 
always do this before printing your final copy). 

 
Update using the option that best applies to your needs. 

5. Click OK. 

Make sure you update your TOC before printing your final draft. Page 
numbers and headings may have changed since the last time you updated. 

 

Copyright Statements 
Your documentation you create for the TWRT classes is your intellectual property 
(except in the case of TWRT-64 where you create documentation for a client). Your 
work may belong to the company for which you write if you receive remuneration for 
your work. The copyright statement protects your property and the work you create 
for your employers. For smaller private works a small copyright statement on the 
bottom of the title page may suffice. For larger documents, especially those created 
for your employer should be provided on its own page, the copyright page. 

The copyright page includes any copyright and trademark information pertinent to the 
material. You should also mention any third-party trademark information included 
within your document. Your employer and any third-party companies are likely to 
provide you with their standard copyright formula. When writing a copyright page for 
your TWRT class work, you are the author and may use your creative liberties.  

Style recommendations for copyright statements: 

• Use the same font style or one point size smaller than your standard body text. 

• Begin with the copyright symbol © or the word copyright (the symbol is the 
preferred method). To create the copyright symbol in Microsoft® Word, type 
a left parenthesis followed by c then a right parenthesis (c). Word 
automatically converts this to the copyright symbol. 

• Give the publication year directly after the copyright symbol. If subsequent 
publications occur, you may either include the years separated by a hyphen 
(as in 2000-2005) or use a comma to separate non-consecutive years (2000, 
2003). 
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• The name of the copyright owner follows the copyright year. The owner is not 
necessarily the writer. 

• The phrase, “All rights reserved” is not followed by a period unless it’s 
followed on the same line by additional text. 

• Keep the statement to one page unless your company has a specified 
copyright notice that spans to more than one page. 

Examples of copyright statements: 

© 2005 by Name. All rights reserved 

© 2001-2004 by Name. All rights reserved 

© 1999, 2001, 2006 by Name. All rights reserved 

© 2001 by Name. 
All rights reserved. No part of this document may be reproduced or transmitted in any 
form or by any means, electronic, photocopy, mechanical, recording, or otherwise 
without prior permission of Name. 

Introductions 
A preface is a fancy word for introduction. It’s not required for your TWRT 
documentation but may help to present the subject matter. A preface introduces your 
subject and encourages the reader to continue reading. If you are only writing a short 
document of about 15 pages, keep the preface short. The preface length should be 
proportionate with the overall length of your document. Don’t overwhelm your reader 
with a lengthy preface. 

The basics of a preface: 

• Introduce the subject matter. 

• Provide reasons why the subject matter is important to the reader. 

• Give the reader reasons why you are a reliable source for the subject matter. 

• Include a history of the subject matter if it is necessary for the reader to have 
more information in order to understand the information in the document. 

Document Content 
The main part of the document is the content. This part is the essence of your 
document. Your content can be divided into chapters, sections, or may be presented in 
one section with paragraphs. Whichever way you divide your content depends on the 
size of the material you want to present. This section helps you to understand the 
various parts of content presentation. 

Fonts 
In any document you have different parts, such as titles, headings, bulleted lists, 
captions, procedures and so on. All of these elements of a document have a specific 
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purpose, and applying proper fonts styles and sizes to these elements enhance their 
readability. Fonts refer to the appearance of your text. 

Fonts can be divided into two broad categories: Serif and Sans Serif. Serif fonts have 
little lines at the end of the letter, called the serif. The serif creates a more natural 
flowing look to the text which makes it easier to read. Examples of serif fonts are: 
Times New Roman, Bookman Old Style, and Courier New. Sans serif fonts do not 
use serifs, the small lines at the ends of characters. A few examples of sans serif fonts 
are: Helvetica, Arial, Impact, Microsoft san serif, and Tahoma 

Generally the titles and heading elements of your document should use a sans serif 
font in a larger size. The larger fonts help grab the users attention and the help them 
find the section on a page. The serif fonts are used in the body text, lists, bullets and 
similar parts which are heavy with text. 

Chapter Titles 
If your content can be organized into major categories and is large enough, you can 
divide the content into separate chapters. Each chapter should have a title and must 
have an introductory paragraph to summaries the topics covered in the Chapter. Each 
chapter must begin on a new page, while printing on both sides a page start the 
chapter on the odd numbered page. For an example of chapter title appearance, see 
White Space & Readability. 

When writing Chapter Titles: 

• Make sure that the chapter title appears at the top of the first page of the 
chapter. 

• Use a larger font size than used in your Section Headings. 

• Select fonts and colors that enhance the title. 

• Avoid punctuation at the end of the title. 

• Add a visual element, such as lines, shading, icons, and numbers, but avoid 
using too many elements at one time. 

• Leave at least 18-point space or more after each chapter title, (see Formatting 
Paragraphs). 

• Keep the format and style for all the chapter titles in one document consistent.  

• Try to keep all the chapter titles in one document parallel. 

Section Headings 
Body text, depending on the flow of information or the content, can be organized into 
sections and sub-sections. Each section or sub-section must have a heading; the 
section heading is generally referred to as Heading 1 and the subsequent sub-headings 
are called Heading 2, Heading 3, and Heading 4. You should not have more than 4 
levels of section headings in a document, or 3 headings if you’re using Chapter Titles. 
Try to reorganize the document if there are more than 4 levels of sections. Format 

32 



Student Style  Formatting Your Documents 

your pages so that your headings are not separated from the section content they 
introduce. For an example of heading appearance, see White Space & Readability. 

Writing a Heading 1 
A Heading 1 (H1) is your first level of headings and can take the place of Chapter 
Titles if you choose not to divide your work into chapters. Ensure that the words in 
your heading directly relate to the content in the section following the heading. 
Always follow a heading with a paragraph to introduce and explain the content. 

Styles and formatting suggestions for H1s: 

• Use a sans serif font, (see Fonts). 

• Use 16-18 point font size. 

• Bold your text. 

• Make sure all H1s in the chapter are parallel.  

• Avoid punctuation at the end of your H1s. 

• Use the same format and style for all H1s throughout the document. 

• Leave 16-18 point space before the H1s and about 6 pt. space after, (see 
Formatting Paragraphs). 

• Create a style H1 or use the available style from MS-Word, Heading1. 

Writing a Heading 2 (H2) and Subsequent Subheadings 
Headings 2 and 3 (H2 and H3) are subheadings. Try to use the rule of twos where you 
have a minimum of two subheadings, rather than having just one orphan subheading. 
Consider revising you content to group like items together. As with H1s, ensure that 
the text in your H2 directly refers to the content presented in the section and that it is 
directly followed by a paragraph to introduce and explain your content. 

Styles and formatting suggestions for a subheading: 

• Use a sans serif font, (see Fonts). 

• Use 12-16 point font size in bold. 

• Make sure all headings of the same level parallel. 

• Avoid punctuation at the end of headings. 

• Use the same format and style for all same-level headings. 

• Leave about 12-point space before the headings and about 6 points space 
after, (see Formatting Paragraphs). 

Formatting Paragraphs 
A paragraph deals with a particular point or idea. A paragraph starts with the main 
point, followed by sentences with supporting details. A paragraph goes from the 
general to the specific to advance an argument or point of view. Each paragraph builds 
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on what came before and lays the ground for what comes next. Keep your paragraphs 
small, about 6-7 lines. Do not indent you paragraphs 

Body text is often referred to in the TWRT classes as your paragraph style. Word has 
a Body Text style predefined but the default style in Word is Normal.  

Styles and formatting suggestions for body text: 

• Ensure the text is left-justified, (see Setting up Page Layout 
The appearance of your page is the key to communicating to your reader.  Margins, 
spacing between words, and the hierarchy of your headings and body text all 
determine whether your reader would want to keep reading your content.  Proper page 
layout allows the beginning user to recognize your organization quickly and to 
assimilate the ideas quickly.  If formatted well, the same page layout allows the 
returning, or “power” user to access and reference main points without stumbling 
through endless blocks of body text. 

You should set up your page layout before you begin writing. This includes setting 
margins and determining where your text goes. The previous section discussed 
showing rulers. Rulers help you set your margins, tabs, and indentations. To access 
the page setup dialog box, simply double-click in the gray area in your ruler, or click 
File → Page Setup. The sections that follow are intended to help you to set up your 
page layout for most documents but remember that all documents are different and 
may require different settings. 

• White Space & Readability. 

• Use a serif font, in 10-12 point size, (see Fonts).  

• Use minimal text effects such as bold or italics; never use underline. 

• Organize the content in paragraphs and ensure continuity in narration.  

• Keep paragraphs brief, smaller than 7-8 lines if possible (see Being Concise). 

Writing Definitions 
Definitions are necessary for ensuring that your reader understands your content. 
Reader comprehension begins to fail when the reader hits a complex or industry-
related word without any definition provided. The reader might not even realize where 
the breakdown of communication occurred, but will definitely notice frustration at not 
understanding the intent of the document.  

Suggestions for writing definitions: 

• Don’t assume your reader knows all of the industry-related jargon or 
vocabulary used in your document. When in doubt, define. 

• Bold the word the first time it is used in your document. 

• Define the word when you first present it in your document. 

• Give examples where necessary to ensure better reading comprehension. 
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• Provide a glossary of terms in the back of your document including all of your 
defined terms and their definitions. 

Introducing Content with List Intros 
A List Intro is a line of text used to introduce a bulleted list, numbered list, table or 
figure. Ensure that the text used in your List Intro accurately and briefly describes the 
content to follow. As with everything, maintain consistency throughout your 
document so if you are using List Intros, ensure that you use them consistently and 
format them the same in all instances. 

Styles and formatting suggestions for writing List Intros: 

• Use the same font style and size as the body text. 

• Always end the List Intro with a colon. 

• Follow the List Intro directly with the content (bulleted list, numbered list, 
table or figure). 

• Align your List Intros appropriately with your body text above and the 
content it introduces below (you may indent the content, but be consistent). 

Alerts: Notes, Cautions, and Warnings 
Alerts like notes, cautions, and warnings (even the word “alert” may be used) convey 
important information that you want the reader to know right away. These parts 
should be placed in the document in a way that captures the reader’s attention.  

Before writing your manual, establish your criteria for using alerts. For instance, notes 
are used for level-1 information important to know but won’t harm the reader’s 
progress in a procedure. Cautions could be used as a level-2 alert where if the caution 
isn’t followed, the reader might experience some level of frustration. Warnings are 
often used as a level-3 alert where the reader’s ability to complete a task is completely 
hampered if not followed. 

When writing alerts: 

• Use a graphic draw attention to the alert, such as a lighting bolt or 
exclamation point enclosed in a triangle.  

• Describe the possible risk and explain actions for the user. Be direct. 
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• Format your alert using styles, (see Understanding Styles) so that your alert 
has consistency with alignment and appearance. 

• Align the alerts into the white space on the left to ensure visibility. 
Examples of alerts: 

 

 

Footnotes and Endnotes 
Your writing may have references to other sources; you can provide this reference 
with the help of endnotes or footnotes. Wherever you use information that was written 
by someone else, you need to provide a reference to that source; otherwise you run the 
risk of plagiarizing someone else’s work. When using endnotes and footnotes, you 
should include a bibliography with your document providing the full details of all 
your sources, (see Works Cited and Bibliographies). 

The use of either footnotes or endnotes depends on the protocol your teacher wishes 
you to follow, or sometimes you may choose your method. Most instructors at 
DeAnza prefer the Modern Language Association protocol for citing sources, (see 
Appendix: Resources). 

Using Footnotes 
Footnotes appear within your text as superscript numbers or symbols. The numbers in 
footnotes refer to information at the bottom of the page which contains more 
information on the subject or just a reference to the source from which it comes. Some 
people often confuse the term footnote with endnote and use the term footnote to refer 
just to the citing of the source within your body text. 

Styles and formatting suggestions for footnotes: 

• Place superscript consecutive numbers on the text you want to cross-reference 
when using footnotes.  

• Provide a reference at the foot of the page for each footnote used. 

• Avoid using sub-notes, such as 2a, 2b. 

• Keep your footnotes in your body text; avoid placing them in headings and 
titles. 

• Use a font size smaller than that of the body text; this is usually sufficiently 
accomplished when superscripting the font of the footnote. 

Save money by reusing the packaging provided with 
your purchase. Bags may be reused for up to one 
year. 

Make sure you count the nuts and bolts. You need 
8 of each to complete your project, otherwise it will 
fall apart. 
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Using Endnotes 
Endnotes, like footnotes, are references within text to another source or more 
information. Endnotes are meant to direct the reader to the end of the document for 
more information found on a Works Cited page or Bibliography (see Works Cited and 
Bibliographies). Endnotes are often termed parenthetical citation since they appear 
within parentheses instead of superscripted numbers like footnotes. For more 
guidelines on using parenthetical citations, see the Modern Language Association 
(MLA) Style Guide. 

Bulleted Lists 
A bulleted list presents information in a short format, making it easier for the reader to 
read. Instead of paragraphs of information the reader gets information broken-up into 
sentence-sized chunks. A bulleted list should only be one level. In other words, try not 
to have lists within lists (sub-bullets) unless absolutely necessary. 

When using a bulleted list, ensure that you have a minimum of two points. A single 
line is not a list. Do not use a bulleted list to convey steps that should be done in order, 
(see Writing Procedures in Numbered Lists).  

Styles and formatting suggestions for bulleted lists: 

• Introduce the list with a List Intro ending with a colon. 

• Use consistent punctuation within the list. 

• Capitalize the first word of each line in the list. 

• Keep the structure of the bullets parallel. 

• Use the same font style and size as the body text. 

• Use verbs at the beginning of the line wherever possible. 

Writing Procedures in Numbered Lists 
Steps are instructions that you want you reader to follow in sequence to complete a 
task. Numbered lists and procedures differ from bullet lists in that they specify a 
particular order by which an action or process must take place.  The order of the 
instructions is very important, and you must number each step and write clearly what 
the user must do at each step to complete the task. Avoid cross-references to other 
parts of the document or any other source. 

Before you begin your procedure or numbered list, provide an overview of the process 
or actions to provide your reader with a summary of what he or she is about to 
undertake.  Each numbered item should stand alone as one action.  Do not include two 
actions in the same command line unless they must be done simultaneously.  For 
example, While holding the base of the pod firmly with your left hand, twist the top 
clockwise until you hear an audible click. 

Microsoft® Word automates the numbered list process, which can make it easier for 
you to write procedures, but this feature has some bugs, so keep a close watch on your 
numbered lists to ensure that they appear as you intend.   
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Styles and formatting suggestions when using numbered lists: 

• Introduce the steps with a List Intro. 

• Start each step with a verb indicating the action.  

• Assign one step for each action. Combine two actions into one step only if 
they need to be done together. 

• Use the same font and size as body text, but bold the command to ensure 
visibility to the important actions.  

• Each step must be a complete sentence. 

• End each step with a period. 

• Follow each step with any additional information or the response to the action 
performed in the step.  

• Show the result of the step in form of text, figures, images, or screen shots. 

• Add alerts wherever needed. 

38 



Student Style  Formatting Your Documents 

A good set of steps utilize all the formatting as indicated above to express clear, 
concise, and direct instructions to the reader.  See the sample below: 

 
Most companies have strict guidelines for writing procedures. 

 

Numbered lists have a tendency to get out of sequence in Microsoft® Word. 
This is a bug that can be difficult to fix. To restart numbering: right-click the 
number at the beginning of your list and choose Restart Numbering. If the 
numbering isn’t immediately fixed, type ctrl+Z (undo) and the problem will 
likely resolve itself. NOTE! 

NOTE! 
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Tables 
Tables are an ideal format for presenting large a number of similar facts or data. 
Tables make this easier by allowing you to compare the data using rows and columns. 
Information that is similar such as parts of a unit and their description can best be 
described with a table. 

An example of using a table for comparisons and descriptions: 

 

Styles and formatting suggestions for tables: 

• Use a List Intro to refer to the table just before table. 

• If you have more than one table in a document, label the table as Table-1, 
Table-2, etc. or Table 1-1, Table 1-2, etc. 

• Ensure that each column in a table has a heading and that the heading 
accurately relates to the content in the column. 

• Capitalize the column headings, but avoid any punctuation. 

• Use body text font style and size for the table text. 

• Avoid bold in the table text except for headings.  

• Avoid big paragraphs in table cells. Try to use bulleted lists to increase 
readability. 

• Align the text uniformly, preferable on the left.  

• Resize the column width to fit the content; don’t use really long columns of 
empty space. 
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• If the table runs more than a page, repeat the column headings at the 
continuation of the table on the next page. 

Images and Figures 
Images and figures provide relief from reading and convey certain ideas to the reader 
more easily than words. Images or figures could be pictures, diagrams, charts, or 
screen shots. Callouts are text references within the image to call the reader’s attention 
to certain parts of the image, (see Callouts). 

Styles and formatting suggestions for images and figures: 

• Introduce each image with a List Intro when they are provided as examples; 
this doesn’t apply to images within steps or numbered lists. 

• Align the image with the above text or center-align the image. If the image is 
within a list, ensure that it appears aligned with the body text and not the 
bullets or numbers in the list. 

• Add callouts to explain or name different parts of the image if this helps the 
reader to understand the image, (see Callouts). 

• Group the images with any attached callouts or other linked images. 

• Give each image a number and caption. 
The image or figure that you want to insert can be a picture stored in a separate file, 
clipart present on your computer, flowchart that you want to create, auto shapes 
present in Microsoft Word, or a chart stored in a separate file. All these images can be 
inserted between text in your document using the Insert menu option. 

Using Clip Art 
Clip art consists of stock images that are usually free to use. The Microsoft® Office 
Suite contains a library of clip art that you may use with as part of your license 
agreement. If your publication will be distributed to a large audience or if you are 
charging for the finished published work, you should check the terms and copyright 
restrictions on any art you use. 

To insert  Clip Art: 

1. Select Insert option from the menu. 

2. Select Picture option from the dropdown menu. 

3. Select Clipart option from the menu. The Insert Clip Art task pane appears 
on the right side of your screen. 
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4. Use keywords to search for the clip art that suits your requirements. 

5. Insert the clip art by double-clicking the picture you select from your 
choices presented by your search. 

Flowcharts 
Flowcharts are used to show relationships. They can depict the flow of information or 
steps in process or they can show the structure of a department, object, or process. 
Mainly, they are a good way of simplifying a process for the user. Flowcharts do not 
explain a process in great detail, and the description of the chart should be added in 
the later sections, but flowcharts can be used very effectively to make your user 
understand a complicated process at a higher level without presenting the inner 
details. Once the user understands the top-level design or flow, you can introduce the 
details in subsequent sections. 

Commonly used flowchart symbols: 
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Styles and formatting suggestions for flowcharts: 

• Use known symbols in your flowcharts. 

• Use a sans serif font one size smaller than the body text for the text in the 
flowchart. 

• Use arrows to indicate the flow. 

• Orient the flowchart in one direction; let the flow be in vertical or horizontal 
direction. 

• Use connectors to continue the flowchart on the next page. 
Creating Flowcharts: 

1. Click the AutoShapes menu button present on the Drawing toolbar at the 
bottom of the screen. If the Drawing toolbar isn’t there, right-click on the 
bottom border and check Drawing from the list. 

 
2. Select Flowchart from the menu. 

 
3. Select the desired symbol from the list of flowchart symbols. A picture box 

appears in your document. 

4. Draw your shape in the picture box. 

5. Select the AutoShapes button again. 

6. Select Lines from the menu. 
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7. Select the desired style of lines. 

8. Place the line symbol to connect it to the symbol you created. 

9. Repeat steps one thru eight to finish creating your flowchart. 

Following is an example of a flowchart with callouts: 

 

Callouts 
A callout is a visual method for associating explanations, names or text with an 
image, figure, or picture. A callout can also be defined as a label used to identify parts 
of an illustration. Each part of the image that you want to explain or named is 
identified using lines and text. The callout is a simple bit of text around the perimeter 
of the illustration, joined to the part identified with a line. The example of a flowchart 
also contains a few callouts. 
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Styles and formatting suggestions for callouts: 

• Keep the callout lines parallel to each other and short in length. 

• Use a sans serif font, smaller size than body text, for the callout text. 

• Use numbers or legends in the image and explain the legends below the 
image. 

• Keep your callout text brief. Avoid long sentences. 

• Use thin lines in lighter shade for the callout lines. For example, draw callout 
lines in gray-80%. 

• Avoid using arrows in callout lines. 

• Group the images, callouts and caption. Grouping ensures all parts of your 
image moves together. To group: select all items to be grouped, then click 
Draw on your Drawing toolbar and select group. 

Back Matter for Manuals 
Most assignments in the TWRT classes do not require or even apply to having back 
matter. Back Matter is usually included in larger documents like manuals and guides. 
For some guides, you may not even need back matter. You only need to include back 
matter if you wish to provide your reader with indexes or more information that might 
go in an appendix or glossary. 

Back Matter consists of: 

• Glossaries. 

• List of Acronyms and Abbreviations. 

• Appendices. 

• Supplements. 

• Indexes. 

• Sources cited pages (bibliographies). 

Glossaries 
A glossary is a list of definitions that apply to words within your manual. While this 
can be time consuming and intimidating, providing a glossary can be invaluable for 
your reader, especially if your subject matter is highly technical. Include any words in 
your document that might be of question to the reader. The reader’s comprehension of 
your material depends on understanding the verbiage. 

Gathering Definitions 
Do not expect to get all of your definitions from your Subject Matter Experts (SME). 
They may not give you the information you need and may even be annoyed that you 
asked in the first place. Do your best to research the definitions yourself to provide the 
most appropriate definition for your readers. Do not plagiarize definitions from 
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another source. Rather, perform your research and try to put the definitions into your 
own words. 

Some words may be proprietary to your company. In these cases, check to see if your 
company has a company glossary or legal definitions for these words and terms. Use 
company-provided and approved definitions wherever possible. 

Defining Terms 
You’ve made your list of terms and have your definitions. Place your glossary in the 
back of your document behind the appendices, if there are any. 

Styles and formatting suggestions for writing definitions in your glossary: 

• Offer the entire word in its complete form for definition. Provide any 
abbreviations within the definition. 

• List the words and terms in alphabetical order. Terms beginning with numbers 
appear at the beginning of your glossary. Acronyms appear in alphabetical 
order within the rest of the list. 

• Use the same style as your body text plus bold for your terms. 

• Capitalize acronyms and proprietary terms. 

• Follow the term with a colon and then the definition or expansion in regular 
body text. You may create a style specifically for definitions used in the List 
of Abbreviations and Acronyms and the Glossary of Terms. 

• Keep the definitions brief. 

• Change the word form when necessary to ensure accuracy of the definition or 
ease of defining. For instance, it may be necessary to change a noun to a verb 
to make it easier to define. 

Validating Your Glossary 
While you may not have needed your SME to create your glossary, you require your 
SME for fact checking. Once you’ve done your research and compiled your glossary, 
choose a SME that would best help with the specified terms. Ask your SME to correct 
any terms that are wrong, and validate any correct terms. Also ask the SME to mark 
any definitions of which he or she is unsure. After you have received it back from 
your first SME, send it to more SMEs one at a time to ensure consistency with your 
definitions. 

Lists of Abbreviations and Acronyms 
Most technical documentation contains abbreviations and acronyms. These 
abbreviations and acronyms may be widely used in common practice or may be 
specific to the technology within your documentation. Never assume that your reader 
is familiar with your abbreviations or acronyms. Provide the term in full when first 
using the abbreviation or acronym and for good measure, include a List of 
Abbreviations and Acronyms in the back matter of your document for your reader to 
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use as a quick reference guide for understanding abbreviations and acronyms used 
throughout your document. 

Styles and formatting recommendations for abbreviations: 

• Offer the entire term the first time it is used followed by the abbreviation or 
acronym within parenthesis. For example: Very High Speed Integrated Circuit 
(VHSIC), Association (Assn.).  

• Treat your List of Abbreviations and Acronyms as you do your Glossary of 
Terms. List each abbreviation or acronym in alphabetical order. 

• Use the same style as your body text for the abbreviation or acronym to be 
defined. Font should be bolded. 

• Follow the term with a colon and then the definition or expansion in regular 
body text. You may create a style specifically for definitions used in the List 
of Abbreviations and Acronyms and the Glossary of Terms. 

Appendices and Supplements 
The inclusion of an appendix is not required for your documentation but may be 
helpful in making your document more complete. Your appendix should include any 
supplemental information pertinent to your subject matter. Appendices may include 
charts, samples, tables, examples and any information that may be helpful to the 
reader, but didn’t quite fit in within the frame of the document. You may reference the 
specific appendices throughout your document to direct your reader to further 
information. 

Style recommendations for copyright statements: 

• Each appendix should be named according to a letter. For example: Appendix 
A, Appendix B, Appendix C and so on.  

• Elaborate on the type of information provided by the appendix by using a 
semicolon. For example: Appendix A: Styles Quick Reference, Appendix B: 
Websites to Explore. 

Indexing 
Providing an index in your document is not required for all assignments but a well-
built index helps your reader find information quickly and easily. While you may 
index as you write, it’s often best to wait until you’ve completed writing your 
document before adding index entries.  

There are two ways to create an index in Microsoft® Word: inserting an index 
through the menu or using a concordance table. A concordance table is the preferred 
method in the TWRT classes, though both are explained here. 

Styles and formatting suggestions for indexes: 

• Use the same style as your body text. 
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• Deal with more than just the words on the page – deal with what the words 
express. You are not just indexing words; you are indexing concepts and 
relationships. 

• Size your entries appropriately. Don’t make them too short or too extensive. 

• Ensure accuracy in your entries. Errors are easy to miss and if not caught, are 
included in your index. Check for misspellings, misnomers, and incorrect 
page listings. 

• Perform a reality check to make sure that your index entries are not 
misleading and do justice to what they refer. 

• Index main headings (topics, tasks, etc.) to produce a “skeleton” index. 

• Look for relationships between concepts. 

• Group like entries together.  

• Search your index for entries that might better belong in a group rather than 
presented individually. 

• Use verbs and nouns, especially for second-level entries. 

• Qualify your entries with second level entries to subdivide page ranges greater 
than 3 pages. Don’t use naked entries. 

• Index illustrations, tables and examples if they can stand alone but don’t index 
them if they aren’t going to help your readers. 

Adding an Index Using a Concordance Table 
Long documents in Word can be indexed easily and quickly by using a concordance 
table. A concordance table is a two-column table of terms that appear in your 
document and should also appear in your Index. 

To create your concordance table: 

1. Open a new document in Word. 

2. Insert a two-column table by choosing Table → Insert → Table… and 
entering 2 columns and as many rows as you think you may need. 

48 



Student Style  Formatting Your Documents 

 
Use the Insert Table dialog box to customize your concordance table. 

3. Click OK to create your table.  

4. Type your table. The column on the left displays text as it appears in your 
document. Note that many of these words appear more than once. Consider 
capitalizations, abbreviations and other variants. The column on the right 
displays text as it should appear in the Index. Use a colon to separate Main 
entries from Subentries. 

5. Include all variants of terms as they appear in your paper in the left column. 

6. Save your table and close your file. 

7. Open your document. 

8. Navigate to the Index and Tables dialog box (Insert → Reference → Index 
and Tables…). 

9. Choose the AutoMark… button. The Open Index AutoMark File dialog box 
opens prompting you to select your file containing the concordance table. 

10. Select the file containing your concordance table and choose Open. The 
Indexing feature does the rest. 

Marking Your Index Entries Using the Menu 
You need to mark your entries before your add your index at the back of your 
document. Marking your index entries means that you are selecting certain text 
(usually heading text) to be included in the index. Be concise with your index text and 
choose only the text that you believe is important for your reader. Imagine that you 
are your audience and choose to index terms that you would probably expect to see in 
the index. 
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Instructions for marking your index entries: 

1. Review your document scanning for terms for indexing. Try to maintain 
consistency and focus on one subject at a time. 

2. Select the text for the index entry by highlighting it. 

3. Copy the text to your clipboard for later use. 

4. Choose Insert → Reference → Index and Tables… from the menu. The 
Index and Tables dialog box appears. 

 
Use the menu to access the Index and Tables dialog box. 
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5. Choose the Index tab. 

 
The Index tab shows your indexing options. 

6. Choose Mark Entry… The Mark Index Entry dialog box appears. 

 
The Mark Index Entry dialog box allows you to customize your index 
entries. 

7. Change the text in the Main entry box to the general term under which your 
index entry should appear. For example, Indexing would be the general term, 
Marking Your Index Entries would be the subentry. This is where copying 
your text to the clipboard comes in handy. 

8. Choose Mark to mark the text as an index entry. In the example in step 6, the 
entry would look like: { XE "Indexing:Marking Your Index Entries Using the 
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Menu" }. The dialog box stays open while you mark the rest of your index 
entries following steps 1,2,3 and 6 (skip steps 4 and 5 as long as the dialog 
box remains open). 

9. Continue marking entries until you are satisfied with your selections. 

10. Proceed to insert your index by following the instructions in the next section. 

Inserting an Index 
Inserting your index is a lot like inserting a Table of Contents (TOC), (see Table of 
Contents). In Word, an index is a field and therefore, is dynamic and can be updated 
as you progress with your document. Most of the time, just like with the TOC, you 
need to update your fields manually. Be sure to update and check all fields before 
printing your final draft. 

Inserting your index: 

1. Navigate to the end of your document. 

2. Insert a section page break (see Page and Section Breaks). 

3. Choose Insert → Reference → Index and Tables… to reopen the Index and 
Tables dialog box. 

 
The Index and Tables dialog box reappears. 

4. Choose the Index tab. 

5. Check the formatting in the Print Preview window. 

6. Choose Modify… to change the appearance of your index. You may use the 
other options offered directly on the Index and Tables dialog box to make 
additional formatting changes. 

7. Click OK. Your index appears in the location you selected at the end of your 
document. 
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Updating Your Index 
If you make changes to your document that affects the marking or pagination after 
you’ve inserted your Index, simply click anywhere inside your Index and press F9. 
The Index automatically updates.  

Works Cited and Bibliographies 
Citing Sources is extremely important when writing documentation, even technical 
documentation. The type of citation you use depends on the requirements of the 
assignment and your instructor. Some instructors insist upon the Modern Language 
Association (MLA) format. Others prefer the American Psychological Association. 
Sources may be cited either within the paragraph as a parenthetical citation (MLA or 
APA) or may be done using footnotes.  

Sources cited within your text, with footnotes, or endnotes must be included in the 
back matter in a bibliography or a works cited page. For information on MLA or APA 
standards, see their respective books. You can find these resources at your local 
library or bookstore and they are updated regularly.
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Appendix: References 
You might find the following books useful for your TWRT projects: 

Langer, Maria, Microsoft Office Word for Windows 2003, Berkeley: Peachpit 
Press, 2004. 

Aaron, Jane, The Little, Brown Compact Handbook, Reading: Addison 
Wesley Educational Publishers, Inc., 2001. 

Strunk Jr., and White, E.B., The Elements of Style, Needham Heights: Allyn 
and Bacon, 1979. 

Webster's Encyclopedic Unabridged Dictionary, New York: Random House 
Value Publishing, Inc., 1996. 

The Staff of the Princeton Review, Grammar Smart, New York, Villard 
Books, 1993. 
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Supplement: Publishing a Manual 

Producing Your Guide or Manual 
To produce your manual, you have to determine paper size, layout of your 
manual page, selection of page and cover paper stock, printing, and binding 
of your manual. Notice that you can accomplish most of the setup process 
with one invocation of the Page Setup dialog box, but for the sake of clarity, 
instructions are included for the different varieties. 

While developing your manual you must complete the following steps: 

1. Determine your page size 

2. Determine your page layout 

3. Create your style template 

4. Choose the page paper and cover paper weights 

5. Print a first draft copy 

6. Choose your binding method 

You are ready to determine your page size and page layout once you have 
your first draft. Draw a left page and a right page lying side by side to 
visualize the layout. If you’re binding your document, you cannot finalize the 
layout until you know whether you’ll choose a lay-flat binding or one that 
does not allow the pages to lie completely flat. Make your size and layout 
choices early and experiment with them, so that you are not rushing in the 
last weeks of the quarter. This process requires time. 

Determining Your Page Size 
Once you have some initial material you are ready to format your document. 
The first choice to make is the size of the page. Microsoft Word allows you 
to set up your page size, margins, and page layout options by using the Page 
Setup dialog.  

The most common page sizes are 8.5" by 11" and 7" by 9". Companies often 
provide hard copy manuals in the 7 by 9 format. For example, suppose that 
you choose page size 7" by 9". 

To set your document page size to 7" by 9": 

1. Click on the File pull down menu and click on Page Setup. The 
Page Setup dialog box appears. Notice the tabs for Margins, Paper 
Size, Paper Source, and Layout. 

2. Click on the Paper Size tab. The Paper Size section appears. 

3. Set the Width field to 7". 

4. Set the Height field to 9".  
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5. Leave the orientation as Portrait since that is the most common 
orientation.  

6. Make the selection to the Whole document.  

7. Click the OK button when finished. 

Gutters 
The gutter is the area next to the vertical edge of the paper that goes 
underneath the binding. Before you determine your gutter, decide whether or 
not your document needs binding or whether can be stapled. For larger 
documents such as manuals and guides, you need to plan for binding and 
determine what kind of binding to use. If you are binding your document, 
give 3/4" spacing for both spiral bound and staple & tape bound manuals. 

Setting the gutter to 3/4": 

1. Click on the File menu and choose Page Setup. The Page Setup 
dialog box appears. Notice the tabs for Margins, Paper Size, Paper 
Source, and Layout.  

2. Click on the Margin tab.  The following task pane appears: 

  
3. Set the Gutter field to 0.5".  
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4. Make sure that Gutter position is set to Left.  

5. Click OK when finished. 

Different Left and Right-Side Pages 
Having different left and right sides helps you to designate page numbers, 
chapter titles, and document titles to predetermined locations on your pages.  
For example, you might want the page numbers to always show   

Setting different left and right-side pages: 

1. Click on the File menu and choose Page Setup. The Page Setup 
dialog box appears. Notice the tabs for Margins, Paper Size, Paper 
Source, and Layout. 

2. Choose the Layout tab.  

3. Click on the Section start pull down menu. Look at the selections. 

 
4. Choose New page, Even page, or Odd page, depending on the 

desired effect.  

5. Click OK when finished. 
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Page and Section Breaks 
A break is a place where the type is divided as in at the end of a paragraph or 
a page.  

Page breaks simply break the text up into multiple pages without changing 
the headers, footers or any other page layouts. Section breaks are more 
complex.  

Section breaks allow you to apply different text to your headers and footers 
on different pages. For instance, if you want to have your page numbers in 
Roman numerals in your front matter, but have standard format numbers in 
the document body, then you need a section break to tell Word to treat these 
sections differently. 

You must create section breaks if you want to create separate headers and 
footers for each chapter or major sections. If a section break specifies the 
new section starts on an odd (right side) page, Word may create a blank even 
page at the end of the previous section. This page is numbered (though the 
page number does not show), but does not contain content in the header and 
footer. You must first set up the way the section starts using the Page Setup 
dialog box before setting the section breaks.  

Creating a Next page section break: 

1. Click on the Insert menu and choose Break.  The following task 
pane appears: 

 
2. Select Next page under the Section break types area. 

3. Click OK when finished. 

Headers and Footers 
Headers and footers are aptly named for the area at the top and at the bottom 
of your page. The headers and footers lie within the margin. You may not use 
this area for most of your assignments such as memos, résumés, letters, etc. 
The header and footer space is important, however, for longer documents like 
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guides, manuals and any document that spans more than a page or two. 
Inside the header or footer, you may include information such as the 
document title, your name, the page numbers and sometimes chapter titles 
and section names. 

 

Working with Headers and Footers Together 
You can choose to have the header on odd pages to the right and the header 
on the even pages to the left. You can also have the document title in the odd 
page header and the major section or chapter title in the even page header. 
You can use the same mirroring for the footers on odd and even pages. 

Document Headers and Footers  
Headers and footers are consistent throughout your document if you don’t 
use any section breaks or choose not to link them to previous headers and 
footers. If you don’t know what this means, don’t worry, it’s covered in the 
next section, Section Headers and Footers.  

Entering content into your headers and footers: 

1. Place the cursor on the first page of your document.  

2. Click on the View menu.  

3. Choose Header and Footer. Notice the Header and Footer dialog 
box. 

 
4. Enter your header content as you want it to appear in your manual. 

5. Click the  button to switch to the footer. 

6. Enter your footer content as you wish it to appear in your manual. 

7. Click Close when done. 

Section Headers and Footers 
The content in your headers and footers depends on the type of document, 
the document length and the requirements given to you by your teachers. In 

Headers and footers are mainly used in documents longer than two pages. Be 
sure to include your name, your team members’ names and page numbers in 
the header or footer of documents over two pages long. Your teacher may 
have preferences of what goes into your assignment headers and footers. 

NOTE! 

NOTE! 
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larger documents, like a guide or manual, you should have different 
information in the headers and footers in different sections of your 
documents. For instance, you may want to have your chapter titles appear in 
your headers, but they may change every few pages. Use section breaks first 
to separate the different sections, such as at the end of each chapter.  

The headers and footers on the first page of your manual are often different 
than the headers and footers in the rest of your document. For instance, you 
may not want page numbers in the headers or footers on your first page but 
want them on all the subsequent pages. Use a section break at the end of your 
first page to help you maintain different headers and footers. 

Setting different header and footer content: 

1. Create a section break before the page that should contain your new 
header/footer information. 

2. Place the cursor on the first page of your section.  

3. Immediately turn off Linked to Previous   in each header and 
footer (Left, Right, First page) in the second section. Note that you 
must turn off Linked to Previous for a header or footer before you 
make any modifications to that header or footer. 

4. Modify the headers, footers, etc in the section as you desire. By 
doing this only after you have turned off Linked to Previous you 
avoid inadvertently modifying the headers and footers in the 
previous section. 

5. Proceed to generate text and additional section breaks as needed. 
The default is now Not Linked to Previous wherever (Right footer, 
Left header, First page footer, etc) you set it that way the first time. 

Entering Page Numbers 
Headers and footers can contain page numbers. Decide if you want the page 
numbers in the header or footer. Word allows you to insert page numbers 
through the insert menu as a graphic, which you can move around easily, but 
this method is instable and can lead to headaches with larger documents 
containing multiple sections. Although Word has different ways to insert 
page numbers, the easiest way is to insert appropriate auto-text in the header 
or footer using the header/footer dialog box.  

Entering and formatting page numbers in your header or footer: 

1. Click on the View menu.  

2. Choose Header and Footer. Notice the Header and Footer dialog 
box. 
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3. Place your cursor at the place where you want to place your page 

number (you may have to create a tab for this placement). 

4. Click the Insert Page Number icon: . Your page number field is 
inserted and automatically updated on each page containing this 
footer. 

5. Format your page numbers by clicking the Format Page Numbers 

icon: . A dialog box appears. 

 
6. Choose the number format (Roman numerals, Arabic, or other) 

from the pull-down menu. 

7. Choose whether or not to continue page numbering or start at a 
different number. Your front matter should have Roman numerals; 
the rest of your document should have a different format and should 
restart at 1. 

8. Click OK. 

Selecting Your Paper 
After you have printed your first draft, you are ready to determine the page 
paper and cover materials you need to use for your manual. You must 
consider paper weight, surface type, color, and cost. 

Paper weight is the thickness of the paper. Although 24 weight paper is 
adequate for one-sided printing, it is not thick enough to avoid bleed-through 
of images and bold print from the other side of the page. The 
recommendation for manual pages is 60 weight copy paper or sealed surface 
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paper. The recommendation for the cover of your manual is 60 weight or 65 
weight cover stock paper. 

The best color for your pages and cover stock is a brilliant white, 96 bright or 
better. This ensures that your graphics will reproduce in true and bright 
colors. 

There are several sources of page and cover materials in the South Bay. 
Office Max, Office Depot, and Fry's Electronics all have paper and covers at 
reasonable prices, but the page sizes are 8.5" by 11" or 8.5" by 14", which 
means that you must cut your materials to fit your page size. They do not 
have heavy weight papers. Kelly Paper can provide your materials at a good 
price and at your specified size without extra expense. See the Resources 
section. 

Cutting Your Paper 
Whether to cut your paper to 7”x9” before or after printing depends on your 
printer driver. Some printer drivers will correctly align the odd and even 
pages directly behind each other on the same page, whether the paper is pre-
cut or not. Some printers won’t take a pre-cut piece of paper at all. Some 
printer drivers will correctly align the odd and even pages when the paper is 
pre-cut, but not when printing to 8.5”x11” paper, even though the printer 
settings are identical. Sometimes the paper tray is set for different size paper 
based on a single sliding guide on one edge of the paper, or on two linked 
sliding guides that hold the paper in the middle of the paper tray, determining 
whether the printer will print both sides in the middle of an 8.5”x11” piece of 
paper. You have to experiment with your own printer setup, keeping in mind 
these possibilities. 

Printing Your Manual 
Printing can vary greatly depending on the printer, ink, and paper used. The 
tips below can help guide you through printing to the best possible result. 

Always keep “Scale to fit” turned OFF in your printer settings. 

A PDF file prints out nicer than the original Word document. Even if you do 
not see the difference, in many cases printing is faster and fonts truer. 

The two sides of a sheet of paper may print with different image crispness. 
Most paper has a front and back side, and printing does not occur identically 
on the two sides. This is especially true of shiny paper, which may be shinier 
on one side than the other, but is also true of matte paper. If you can identify 
the side of the paper that generates the better print, print the odd pages on 
that side. 

If you print on two sides of the paper by first printing odd pages, then 
returning the printed paper to the paper feeder and printing even pages, make 
sure to let your pages air dry before printing on the other side. Also make 
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sure to not handle the pages very much until they are completely dry, as print 
may smudge or come off. 

If you print on two sides of the paper by first printing all odd pages, then 
returning the printed paper to the paper feeder and printing all even pages, 
never be tempted to examine your odd pages before you have printed the 
even sides also. You can easily lose track of the correct order of the odd 
pages, which may mess up your odd-even page correspondence in the printer. 

If you choose to print copies of your manual at home or school, use the 
following method to print two-sided pages: 

1. Put paper in the printer paper feeder. 

2. Open your document and put the cursor on the first page. 

3. Click on the File pull down menu and click on Print. 

4. In the Page range section, select Current page. 

5. In the Copies section, select the number of copies to print. 

6. Click OK. 

7. Place the copies face down in the printer paper feeder. 

8. Put the cursor on the next page. 

9. Click on the File pull down menu and click on Print. 

10. In the Page range section, select Current page. 

11. In the Copies section, select the number of copies to print. 

12. Click OK. 

13. Continue steps 1 through 12 with successive pairs of pages. 

Binding Your Manual 
Spiral-bound and staple&tape-bound are two methods of binding that are 
reasonably priced for a college project manual. Examine the sample manuals 
your instructor brings to class and choose the best method for your manual. 

The spiral -bound method must be done by a print service, such as Kinkos. 
Kinkos can also produce your manual as staple&tape-bound. Visit a Kinkos 
store to learn more about what they can do for you. 

You can bind your manual with staples and tape at home. You must have a 
good stapler, like the medium size Swingline model. You must have binding 
tape or a heavy construction paper. You can obtain binding tape from 
University Arts. See the Resources section. 

 Printing Resources 
You can find a very good selection of papers at good prices at Kelly Paper, in 
Palo Alto or Santa Clara. Get the free Kelly Paper Price Book while you are 
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in the store. If you order a week in advance, Kelly Paper will cut the paper to 
your size at no extra charge. Visit Kelly Paper at 
http://www.kellypaper.com/. 

University Arts, in Palo Alto or San Jose, has various construction papers 
and book binding tape in black or white for about $12 a roll. Visit University 
Arts at http://www.universityart.com/. 

Kinkos Copiers are in every town in the South Bay. Kinkos can print and 
bind your manual, either spiral-bound or staple&tape-bound. Visit Kinkos at 
http://www.kinkos.com/. 
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Glossary of Terms 
Acronym: a word formed from the initial 
letters of a series of words. 

Alert: a message that requires attention. 

Appendix: supplemental material 
collected and provided at the end of a 
book. 

Body Text: the typed portion of a page, 
the content, excluding headings and other 
title styles. 

Bulleted List: a list element indicated by 
a bullet at the beginning of each line. 
These are used to present unordered 
information. 

Callouts: text that explains a portion of an 
illustration. 

Content: the meaning or message 
contained in a document. 

Context: circumstances and conditions 
surrounding an event. 

Copyright: exclusive rights granted for a 
limited time to protect original work. 

Endnotes: citations within text that 
applies to information provided at the 
back of a document. 

Footnotes: citations within text, usually a 
superscripted number, that refers to 
information at the bottom of a page. 

Formatting: the size, style, type, page 
layout, attributes, margins, printing 
requirements, etc. for a publication or 
document. 

Gerund: verbal form ending in ing. 

Gutter: white space formed on the inner 
margins of facing pages. 

List Intro: a line of text used to introduce 
a bulleted or numbered list. 

Mirror Margins: opposing margins, left 
and right, often used for documents that 
require binding. 

Numbered List: a list element indicated 
by a number at the beginning of each line. 
These are used to indicate steps that must 
be completed in order. 

Page break: a break inserted manually to 
separate pages or create a new page. 

Parallelism: aligning text on the left 
consistently throughout styles. 

Parenthetical Citation: citing of sources 
within parentheses at the end of a line. 
Refers to information at the end of a 
document, usually in a bibliography or 
works cited page. 

Plagiarize: copying the intellectual 
property of another and claiming it as 
one’s own. 

Procedure: a sequence of steps to instruct 
in how to perform a task. 

Sans Serif: fonts without serifs, little lines 
at the edges of characters such as letters 
and numbers. 

Section Breaks: breaks between sections 
of a document that are necessary for 
having different header and footer content. 

Serif: fonts with serifs, little lines at the 
edges of characters such as letters and 
numbers. 

SME: Subject Matter Expert. 

Style: a manner of expression used in 
writing, particularly word choice, 
formatting, and punctuation. 

Syntax: grammatical arrangement of 
words in sentences. 

Templates: a document with predefined 
styles, formatting, and sometimes 
elements of design. 

Verbiage: wording or manner in which 
ideas are expressed in a document. 
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